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Notice
While reasonable efforts have been made to ensure that the
information in this document is complete and accurate at the time of
printing, Avaya assumes no liability for any errors. Avaya reserves
the right to make changes and corrections to the information in this
document without the obligation to notify any person or organization
of such changes.

Documentation disclaimer
“Documentation” means information published by Avaya in varying
mediums which may include product information, operating
instructions and performance specifications that Avaya may generally
make available to users of its products and Hosted Services.
Documentation does not include marketing materials. Avaya shall not
be responsible for any modifications, additions, or deletions to the
original published version of documentation unless such
modifications, additions, or deletions were performed by Avaya. End
User agrees to indemnify and hold harmless Avaya, Avaya's agents,
servants and employees against all claims, lawsuits, demands and
judgments arising out of, or in connection with, subsequent
modifications, additions or deletions to this documentation, to the
extent made by End User.

Link disclaimer
Avaya is not responsible for the contents or reliability of any linked
websites referenced within this site or documentation provided by
Avaya. Avaya is not responsible for the accuracy of any information,
statement or content provided on these sites and does not
necessarily endorse the products, services, or information described
or offered within them. Avaya does not guarantee that these links will
work all the time and has no control over the availability of the linked
pages.

Warranty
Avaya provides a limited warranty on Avaya hardware and software.
Refer to your sales agreement to establish the terms of the limited
warranty. In addition, Avaya’s standard warranty language, as well as
information regarding support for this product while under warranty is
available to Avaya customers and other parties through the Avaya
Support website: https://support.avaya.com/helpcenter/
getGenericDetails?detailId=C20091120112456651010 under the link
“Warranty & Product Lifecycle” or such successor site as designated
by Avaya. Please note that if You acquired the product(s) from an
authorized Avaya Channel Partner outside of the United States and
Canada, the warranty is provided to You by said Avaya Channel
Partner and not by Avaya.

“Hosted Service” means a hosted service subscription that You
acquire from either Avaya or an authorized Avaya Channel Partner
(as applicable) and which is described further in Hosted SAS or other
service description documentation regarding the applicable hosted
service. If You purchase a Hosted Service subscription, the foregoing
limited warranty may not apply but You may be entitled to support
services in connection with the Hosted Service as described further
in your service description documents for the applicable Hosted
Service. Contact Avaya or Avaya Channel Partner (as applicable) for
more information.

Hosted Service
THE FOLLOWING APPLIES IF YOU PURCHASE A HOSTED
SERVICE SUBSCRIPTION FROM AVAYA OR AN AVAYA
CHANNEL PARTNER (AS APPLICABLE), THE TERMS OF USE
FOR HOSTED SERVICES ARE AVAILABLE ON THE AVAYA
WEBSITE, HTTPS://SUPPORT.AVAYA.COM/LICENSEINFO
UNDER THE LINK “Avaya Terms of Use for Hosted Services” OR
SUCH SUCCESSOR SITE AS DESIGNATED BY AVAYA, AND ARE
APPLICABLE TO ANYONE WHO ACCESSES OR USES THE
HOSTED SERVICE. BY ACCESSING OR USING THE HOSTED
SERVICE, OR AUTHORIZING OTHERS TO DO SO, YOU, ON
BEHALF OF YOURSELF AND THE ENTITY FOR WHOM YOU ARE
DOING SO (HEREINAFTER REFERRED TO INTERCHANGEABLY
AS “YOU” AND “END USER”), AGREE TO THE TERMS OF USE. IF
YOU ARE ACCEPTING THE TERMS OF USE ON BEHALF A
COMPANY OR OTHER LEGAL ENTITY, YOU REPRESENT THAT
YOU HAVE THE AUTHORITY TO BIND SUCH ENTITY TO THESE

TERMS OF USE. IF YOU DO NOT HAVE SUCH AUTHORITY, OR
IF YOU DO NOT WISH TO ACCEPT THESE TERMS OF USE, YOU
MUST NOT ACCESS OR USE THE HOSTED SERVICE OR
AUTHORIZE ANYONE TO ACCESS OR USE THE HOSTED
SERVICE. YOUR USE OF THE HOSTED SERVICE SHALL BE
LIMITED BY THE NUMBER AND TYPE OF LICENSES
PURCHASED UNDER YOUR CONTRACT FOR THE HOSTED
SERVICE, PROVIDED, HOWEVER, THAT FOR CERTAIN HOSTED
SERVICES IF APPLICABLE, YOU MAY HAVE THE OPPORTUNITY
TO USE FLEX LICENSES, WHICH WILL BE INVOICED
ACCORDING TO ACTUAL USAGE ABOVE THE CONTRACT
LICENSE LEVEL. CONTACT AVAYA OR AVAYA’S CHANNEL
PARTNER FOR MORE INFORMATION ABOUT THE LICENSES
FOR THE APPLICABLE HOSTED SERVICE, THE AVAILABILITY
OF ANY FLEX LICENSES (IF APPLICABLE), PRICING AND
BILLING INFORMATION, AND OTHER IMPORTANT
INFORMATION REGARDING THE HOSTED SERVICE.

Licenses
THE SOFTWARE LICENSE TERMS AVAILABLE ON THE AVAYA
WEBSITE, HTTPS://SUPPORT.AVAYA.COM/LICENSEINFO,
UNDER THE LINK “AVAYA SOFTWARE LICENSE TERMS (Avaya
Products)” OR SUCH SUCCESSOR SITE AS DESIGNATED BY
AVAYA, ARE APPLICABLE TO ANYONE WHO DOWNLOADS,
USES AND/OR INSTALLS AVAYA SOFTWARE, PURCHASED
FROM AVAYA INC., ANY AVAYA AFFILIATE, OR AN AVAYA
CHANNEL PARTNER (AS APPLICABLE) UNDER A COMMERCIAL
AGREEMENT WITH AVAYA OR AN AVAYA CHANNEL PARTNER.
UNLESS OTHERWISE AGREED TO BY AVAYA IN WRITING,
AVAYA DOES NOT EXTEND THIS LICENSE IF THE SOFTWARE
WAS OBTAINED FROM ANYONE OTHER THAN AVAYA, AN
AVAYA AFFILIATE OR AN AVAYA CHANNEL PARTNER; AVAYA
RESERVES THE RIGHT TO TAKE LEGAL ACTION AGAINST YOU
AND ANYONE ELSE USING OR SELLING THE SOFTWARE
WITHOUT A LICENSE. BY INSTALLING, DOWNLOADING OR
USING THE SOFTWARE, OR AUTHORIZING OTHERS TO DO SO,
YOU, ON BEHALF OF YOURSELF AND THE ENTITY FOR WHOM
YOU ARE INSTALLING, DOWNLOADING OR USING THE
SOFTWARE (HEREINAFTER REFERRED TO
INTERCHANGEABLY AS “YOU” AND “END USER”), AGREE TO
THESE TERMS AND CONDITIONS AND CREATE A BINDING
CONTRACT BETWEEN YOU AND AVAYA INC. OR THE
APPLICABLE AVAYA AFFILIATE (“AVAYA”).

Heritage Nortel Software
“Heritage Nortel Software” means the software that was acquired by
Avaya as part of its purchase of the Nortel Enterprise Solutions
Business in December 2009. The Heritage Nortel Software is the
software contained within the list of Heritage Nortel Products located
at https://support.avaya.com/LicenseInfo under the link “Heritage
Nortel Products” or such successor site as designated by Avaya. For
Heritage Nortel Software, Avaya grants Customer a license to use
Heritage Nortel Software provided hereunder solely to the extent of
the authorized activation or authorized usage level, solely for the
purpose specified in the Documentation, and solely as embedded in,
for execution on, or for communication with Avaya equipment.
Charges for Heritage Nortel Software may be based on extent of
activation or use authorized as specified in an order or invoice.

Copyright
Except where expressly stated otherwise, no use should be made of
materials on this site, the Documentation, Software, Hosted Service,
or hardware provided by Avaya. All content on this site, the
documentation, Hosted Service, and the product provided by Avaya
including the selection, arrangement and design of the content is
owned either by Avaya or its licensors and is protected by copyright
and other intellectual property laws including the sui generis rights
relating to the protection of databases. You may not modify, copy,
reproduce, republish, upload, post, transmit or distribute in any way
any content, in whole or in part, including any code and software
unless expressly authorized by Avaya. Unauthorized reproduction,
transmission, dissemination, storage, and or use without the express
written consent of Avaya can be a criminal, as well as a civil offense
under the applicable law.

Virtualization
The following applies if the product is deployed on a virtual machine.
Each product has its own ordering code and license types. Note that
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each Instance of a product must be separately licensed and ordered.
For example, if the end user customer or Avaya Channel Partner
would like to install two Instances of the same type of products, then
two products of that type must be ordered.

Third Party Components
“Third Party Components” mean certain software programs or
portions thereof included in the Software or Hosted Service may
contain software (including open source software) distributed under
third party agreements (“Third Party Components”), which contain
terms regarding the rights to use certain portions of the Software
(“Third Party Terms”). As required, information regarding distributed
Linux OS source code (for those products that have distributed Linux
OS source code) and identifying the copyright holders of the Third
Party Components and the Third Party Terms that apply is available
in the products, Documentation or on Avaya’s website at: https://
support.avaya.com/Copyright or such successor site as designated
by Avaya. The open source software license terms provided as Third
Party Terms are consistent with the license rights granted in these
Software License Terms, and may contain additional rights benefiting
You, such as modification and distribution of the open source
software. The Third Party Terms shall take precedence over these
Software License Terms, solely with respect to the applicable Third
Party Components to the extent that these Software License Terms
impose greater restrictions on You than the applicable Third Party
Terms.

Service Provider
THE FOLLOWING APPLIES TO AVAYA CHANNEL PARTNER’S
HOSTING OF AVAYA PRODUCTS OR SERVICES. THE PRODUCT
OR HOSTED SERVICE MAY USE THIRD PARTY COMPONENTS
SUBJECT TO THIRD PARTY TERMS AND REQUIRE A SERVICE
PROVIDER TO BE INDEPENDENTLY LICENSED DIRECTLY
FROM THE THIRD PARTY SUPPLIER. AN AVAYA CHANNEL
PARTNER’S HOSTING OF AVAYA PRODUCTS MUST BE
AUTHORIZED IN WRITING BY AVAYA AND IF THOSE HOSTED
PRODUCTS USE OR EMBED CERTAIN THIRD PARTY
SOFTWARE, INCLUDING BUT NOT LIMITED TO MICROSOFT
SOFTWARE OR CODECS, THE AVAYA CHANNEL PARTNER IS
REQUIRED TO INDEPENDENTLY OBTAIN ANY APPLICABLE
LICENSE AGREEMENTS, AT THE AVAYA CHANNEL PARTNER’S
EXPENSE, DIRECTLY FROM THE APPLICABLE THIRD PARTY
SUPPLIER.

Compliance with Laws
Customer acknowledges and agrees that it is responsible for
complying with any applicable laws and regulations, including, but not
limited to laws and regulations related to call recording, data privacy,
intellectual property, trade secret, fraud, and music performance
rights, in the country or territory where the Avaya product is used.

Preventing Toll Fraud
“Toll Fraud” is the unauthorized use of your telecommunications
system by an unauthorized party (for example, a person who is not a
corporate employee, agent, subcontractor, or is not working on your
company's behalf). Be aware that there can be a risk of Toll Fraud
associated with your system and that, if Toll Fraud occurs, it can
result in substantial additional charges for your telecommunications
services.

Avaya Toll Fraud intervention
If You suspect that You are being victimized by Toll Fraud and You
need technical assistance or support, call Technical Service Center
Toll Fraud Intervention Hotline at +1-800-643-2353 for the United
States and Canada. For additional support telephone numbers, see
the Avaya Support website: https://support.avaya.com or such
successor site as designated by Avaya.

Security Vulnerabilities
Information about Avaya’s security support policies can be found in
the Security Policies and Support section of https://
support.avaya.com/security.

Suspected Avaya product security vulnerabilities are handled per the
Avaya Product Security Support Flow (https://
support.avaya.com/css/P8/documents/100161515).

Downloading Documentation
For the most current versions of Documentation, see the Avaya
Support website: https://support.avaya.com, or such successor site
as designated by Avaya.

Contact Avaya Support
See the Avaya Support website: https://support.avaya.com for
product or Hosted Service notices and articles, or to report a problem
with your Avaya product or Hosted Service. For a list of support
telephone numbers and contact addresses, go to the Avaya Support
website: https://support.avaya.com (or such successor site as
designated by Avaya), scroll to the bottom of the page, and select
Contact Avaya Support.

Trademarks
The trademarks, logos and service marks (“Marks”) displayed in this
site, the Documentation, Hosted Service(s), and product(s) provided
by Avaya are the registered or unregistered Marks of Avaya, its
affiliates, or other third parties. Users are not permitted to use such
Marks without prior written consent from Avaya or such third party
which may own the Mark. Nothing contained in this site, the
Documentation, Hosted Service(s) and product(s) should be
construed as granting, by implication, estoppel, or otherwise, any
license or right in and to the Marks without the express written
permission of Avaya or the applicable third party.

Avaya is a registered trademark of Avaya Inc.

All non-Avaya trademarks are the property of their respective owners.
Linux® is the registered trademark of Linus Torvalds in the U.S. and
other countries.
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Chapter 1: New in this release

The following sections detail what is new in Using the DMC DECT Manager, NN43001-142 for
Avaya Communication Server 1000 (Avaya CS 1000) Release 7.6.

Navigation
• Feature changes on page 7
• Other Changes on page 7

Feature changes
Avaya Communication Server 1000 Release 7.6 introduces support for two more Windows
operating systems for the DMC DECT Manager:

• Windows Server 2008 R2 x64/x86 with all available Service Packs and running the same on
VmWare

• Windows 7 x64/x86 with all available Service Packs and running the same on VmWare

The November 2015 DMC DECT Manager version 1.01.11335, and later is updated to support Java
8. Java 8 is bundled and installed with the latest version of DMC DECT Manager.

Other Changes
There are no other changes for this release.
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Revision History

December 2015 Standard 03.03. This document is up-issued to include information about DMC DECT
Manager version 1.01.11335.

June 2014 Standard 03.02. This document is up-issued to include information about additional
configuration for DMC DECT Manager.

March 2013 Standard 03.01. This document is up-issued to support Avaya Communication Server
1000 Release 7.6.

April 2011 Standard 02.02. This document is up-issued to update links to the Avaya Support
Center to support Avaya Communication Server 1000 Release 7.5..

November 2010 Standard 02.01. This document is up-issued to support Avaya Communication Server
1000 Release 7.5.

June 2010 Standard 01.01. This is a new document created to support CS 1000 Release 7.0.

New in this release
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Chapter 2: Customer service

Visit the Avaya Web site to access the complete range of services and support that Avaya provides.
Go to www.avaya.com or go to one of the pages listed in the following sections.

Navigation
• Getting technical documentation on page 9

• Getting product training on page 9

• Getting help from a distributor or reseller on page 9

• Getting technical support from the Avaya Web site on page 10

Getting technical documentation
To download and print selected technical publications and release notes directly from the Internet,
go to www.avaya.com/support.

Getting product training
Ongoing product training is available. For more information or to register, go to www.avaya.com/
support. From this Web site, locate the Training link on the left-hand navigation pane.

Getting help from a distributor or reseller
If you purchased a service contract for your Avaya product from a distributor or authorized reseller,
contact the technical support staff for that distributor or reseller for assistance.
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Getting technical support from the Avaya Web site
The easiest and most effective way to get technical support for Avaya products is from the Avaya
Technical Support Web site at www.avaya.com/support.

Customer service
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Chapter 3: Installation of DMC DECT
Manager

Contents
The following are the topics in this section:

• Manage DMC DECT Manager Installation on page 11
• Install DMC DECT Manager on page 11
• Uninstall DMC DECT Manager on page 16
• Upgrade DMC DECT Manager on page 18
• Launch DMC DECT Manager on page 21

Manage DMC DECT Manager Installation
The DMC DECT Manager provides a point of access and control to manage a DECT system on an
Avaya Communication Server 1000 system. DMC DECT Manager runs on:

• Windows 2000 Server

• Windows 2000 Professional

• Windows XP Professional

• Windows Server 2003

• Windows Server 2008 R2 x64/x86 with all available Service Packs and running the same on
VmWare

• Windows 7 x64/x86 with all available Service Packs and running the same on VmWare

Use the procedures in this section to install, uninstall, upgrade and launch the DMC DECT Manager
application.

Install DMC DECT Manager
You can download the DMC DECT Manager application from https://support.avaya.com/css/
appmanager/public/support/Downloads/P0607 .
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Important:
The DMC DECT Manager application cannot co-reside with Avaya Communication Server 1000
- Telephony Manager.

Installing DMC DECT Manager
1. Download the DMC DECT Manager application.
2. Double-click DMC_DECTsetup.exe from the DMC DECT Manager Application installation

package.

The Preparing to Install window appears.

Figure 1: Preparing to Install window

The Welcome window appears.

Installation of DMC DECT Manager
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Figure 2: Welcome window

3. Click Next.
The Choose Destination Location window appears.

Figure 3: Choose Destination Location window

4. Click Next to continue with the default path selected, or click Browse to choose a new
destination location.

The Choose Folder window appears.

Manage DMC DECT Manager Installation
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Figure 4: Choose Folder window

5. The selected settings are displayed in the Start Copying Files window.

Figure 5: Start Copying Files window.

6. Click Next.
7. The Installation program checks for the JRE and Access Runtime prerequisites on the

system.

If the prerequisites are present, the Installation program skips to the DMC DECT Manager
installation. Otherwise, the Installation program installs the prerequisites.

Installation of DMC DECT Manager
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Figure 6: Setup Status Installing JRE

Figure 7: Setup Status Installing Access Runtime

8. The DMC DECT Manager installation starts.

Manage DMC DECT Manager Installation
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Figure 8: Setup Status Installation Starts

9. Click Finish to complete the installation.

Figure 9: InstallShield Wizard Complete

Uninstall DMC DECT Manager
The DMC DECT Manager Application must be closed before uninstalling the application.

Installation of DMC DECT Manager
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Uninstalling DMC DECT Manager
1. From the Windows Start menu, select Control Panel.
2. Double click Add or Remove Programs.
3. Select DMC DECT Manager in the list of programs and click Remove.

Figure 10: Add or Remove Programs window

4. Setup starts preparing for the uninstallation.

Figure 11: InstallShield Wizard

5. Uninstallation starts.

Manage DMC DECT Manager Installation
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Figure 12: Uninstallation starts

6. Click Finish to complete the uninstallation of DMC DECT Manager.

Figure 13: Maintenance complete

Upgrade DMC DECT Manager
To upgrade DMC DECT Manager, follow the steps in Upgrading DMC DECT Manager on
page 19.

Installation of DMC DECT Manager
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Upgrading DMC DECT Manager
1. Double click setup.exe from the DMC DECT Manager Application package.

Figure 14: Preparing to Install

2. Click Next to continue with the upgrade.

Figure 15: DMC DECT Manager InstallShield Wizard

The Start Copying Files window appears with the installed location of DMC DECT Manager.

Manage DMC DECT Manager Installation
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Figure 16: Start Copying Files window

3. Click Next to continue. The upgrade starts.

Figure 17: Setup Status

4. Click Finish to complete the upgrade.

Installation of DMC DECT Manager
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Figure 18: InstallShield Wizard Complete

Launch DMC DECT Manager
Installing DMC DECT Manager creates two shortcuts in Start > Programs > DMC DECT Manager
Menu:

• DMC DECT Manager.

Use the DMC DECT Manager shortcut to launch the DMC DECT Manager application and to
configure the DECT Access Systems.

• Backup Restore Utility.

Use the Backup Restore Utility shortcut to launch the DECT Backup and Restore utility.

Note:
With the November 2015 update of DMC DECT Manager version 1.01.11335 and later, it is
necessary to stop the Windows SNMP Trap Service. Also ensure that ports 162 and 5099 are
free, otherwise DMC DECT Manager will not start.

Additional configuration for DMC DECT Manager
About this task
Users might have a complex network configuration with more than one network card or VPN
connection channel. For complex networks, you can include more configuration settings to ensure
more stable functioning for DMC DECT Manager. Use this procedure to manually define settings for
the FTP connection.

Manage DMC DECT Manager Installation
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Procedure
1. Create a new system environment variable with Name set to DECT_LOCAL_IP_FOR_FTP.

2. Enter the IP address of your computer as the Value for this variable.

Note:

For more information about adding environment variables see the documentation for
your Operation System.

Installation of DMC DECT Manager
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Chapter 4: PBX System Configuration

A DMC DECT system is configured to an Avaya Communication Server 1000 (Avaya CS 1000) PBX
for managing handsets. Some of the DECT System parameters are computed based on the type of
CS 1000 system to which the DMC is configured.

To configure DECT Systems in DMC DECT Manager, the user must create a PBX system with a
name and type. The DMC DECT Manager supports two types of PBX systems: “Large System” and
“Small System”. Use the following rules to determine the PBX system type.

• Rule 1: If the PBX Release number is 2111/2121 (Option11C / OptionCSE11C), select Small
System

• Rule 2: If the PBX Release number is anything other than 2111/2121, select Large System

Manage the PBX System
Use the PBX System Properties window to add a PBX system, and to modify or delete an existing
PBX system.

Add a new PBX System
A PBX System must have a unique name and type (large system or small system). A PBX System
name must not contain any special characters.

Adding a new PBX System
1. Select Start > Programs > DMC DECT Manager > DMC DECT Manager.
2. Select New PBX System from the Select drop down list.

New PBX System is the default setting.
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Figure 19: PBX System Properties

3. Enter the name of the new PBX system in the Name text box.
4. Select the type of PBX system from the Type drop down list. There are two options: “Large

System” and “Small System”.
5. Click Ok.

Use the DECT Access System (DAS) window to add DECT systems to a PBX system.

Modify a PBX system
Use the PBX System Properties window to modify an existing PBX system.

Modifying a PBX system
1. Select the PBX system to be modified from the Select drop down list.

The corresponding details for the selected PBX system are displayed in the Details section.

Figure 20: PBX System Properties Details

2. Make the required modifications (for example, Name, Type) and click Ok.

PBX System Configuration
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Figure 21: PBX System Properties modifications

Remove a PBX system
Removing a PBX system removes all data pertaining to that PBX system including DMC DECT
systems configured in it.

Removing a PBX system
1. Select the PBX system to be removed from the Select drop down list.

The corresponding details for the selected PBX system are displayed in the Details section.

Figure 22: PBX System Properties remove

2. Click Remove.

A Remove System confirmation dialog window appears.

Figure 23: Remove System window

3. Click Yes to continue.

The corresponding data of the selected PBX System is deleted.

Manage the PBX System
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Chapter 5: DECT Application features

DECT Application features
The DECT Application provides the following MDECT managing features. The DECT Application
allows you to do the following:

• view the MDECT System provisioning with the DECT Systems window
• view the DMC8 configuration with the Boards (DMC) window
• view base station configuration with the Radio Fixed Part (base station) window
• view subscription information with the Subscriptions window
• upgrade Firmware using the DECT Systems window
• subscribe handsets using the Subscriptions window
• support DMC-8 and DMC (serial only)
• synchronize (update) the DECT Application database to the MDECT system configuration

when the DECT Manager connects to the MDECT system
• collect performance data using the Performance Collection window
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Chapter 6: DECT Systems window

• What you can do with the DECT Systems window on page 27
• DECT Systems window definition on page 28
• Connecting to an MDECT system on page 29
• DECT System Properties dialog on page 31
• Firmware upload on page 34

What you can do with the DECT Systems window
This window allows you to:

• select an MDECT system to view database details or select all MDECT systems to view
database details

• add an MDECT system
• delete an MDECT system
• connect to, disconnect from, lock or unlock a connection between your DECT Manager and an

MDECT system
• open the following windows for selected MDECT systems

- Subscriptions window on page 35
- Boards (DMC) window on page 49
- Radio Fixed Part (base station) window on page 52
- Active Alarm Snapshot window on page 55
- Performance Collection window on page 57
- Retrieve RSSI Snapshot window on page 59
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DECT Systems window definition
The DECT Systems window displays the following:

• File, holds a pull-down menu that allows you to select one of the following:

- Add, creates a new MDECT system with default values and opens the System Properties
dialog

- Delete, removes an MDECT system from the DECT Manager
- Connect / Lock / Disconnect, same functions as the Connect/Disconnect tool
- Properties, opens the System Properties dialog
- Close, closes the client application and all DECT windows opened by that client

• View, holds a pull-down menu that allows you to show or hide the:

- Tool bar
- Status bar

• Applications, holds a pull-down menu that allows you to open the following windows:

- Subscriptions window
- Boards (DMC) window
- Radio Fixed Part (base station) window
- Current Alarms
- Performance Collection window
- Retrieve RSSI Snapshot window

• Firmware, holds a pull-down menu allowing you to open the following windows:

- Upload, loads firmware to DMC (see Firmware upload on page 34)
- Activation, makes a firmware active

• Help, holds a pull-down menu that allows you to select:

- Content and Index
• Tool bar icon, that allows you to click the tool button to:

- Open a connection to an MDECT system selected in the List when the Connection status
shows Disconnected. When opened the icon changes to red.

- Lock the connection to an MDECT system when the Connection status is Connected. This
prevents another user from closing the connection.

- Disconnect from an MDECT system when the Connection status is Connected
- Unlock the connection from an MDECT system when the Connection status is Connected
Locked

Note:
While the Connection status is Connecting or Disconnecting the Connect/Disconnect tool is
disabled. The status bar shows the connection progress.

DECT Systems window
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• List filter, allows you to select one of the following:

- This Meridian only, lists the MDECT System data you select from the PBX System
Properties Window

- All DECT Systems, lists every MDECT Systems data managed by the DECT Manager
• List field, shows the following for the MDECT system or systems selected from the M 1

System Window:

- Meridian 1 PBX name (see DECT System Properties dialog - General tab on page 31)
- MDECT system name (see DECT System Properties dialog - General tab on page 31)
- presence of an alarm (see DECT System Properties dialog - Alarm tab on page 33)
- IP address, for the MDECT system (see DECT System Detailed Connection settings

properties on page 32)
- Primary Access Rights Identifier (see DECT System Properties dialog - Access Right

Identification tab on page 33)
- Concentration mode (see DECT System Properties dialog - Access Right Identification

tab on page 33)
- number of subscribed handsets (see DECT System Properties dialog - General tab on

page 31)
- connection status

• Connection status field, shows the current state of the connection, where:

- Disconnected indicates no communication between the DECT Manager and an MDECT
system.

- Connected indicates communication between the DECT Manager and an MDECT system
for an operation initiated by a user. The connection disconnects when the operation is
finished.

• Operation progress field, shows the last received event associated with the connection, such
as:

- Disconnecting
- Connecting
- Modem Busy
- Dialing

Connecting to an MDECT system
When you open the first connection to a new, installed MDECT system, the DECT Manager
Application retrieves the DMC configuration from the DECT database. The DECT Manager
Application reads the parameters from the MDECT system for the manager database.

Connecting to an MDECT system
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You can do one of the following to open a connection to an MDECT system from a DECT Manager
Application:

• check the Permanent Connection box, (see DECT System Properties dialog - Communication
tab on page 32), allowing the connection to open when the DECT Manager starts

• select an MDECT system in the list and click the Connect icon
• select an action on the menu bar that requires a system connection. For example, Firmware >

Upload; the connection opens to carry out the upload and then closes.

Note:
Avoid using this type of connection opening for subscription actions otherwise the subscription
status is not refreshed when an on-air subscription or de-subscription occurs.

The status bar of the application provides progress feedback while the connection is opening.

See also

• Synchronization when the DECT Application connects to an MDECT system on page 30

Synchronization when the DECT Application connects to
an MDECT system

When your DECT manager connects to the MDECT system, synchronization occurs.
Synchronization compares the database on your manager to that of the MDECT system. Database
mismatches are flagged by dialogs. You then have the opportunity to change either the MDECT
system data or the manager data.

A number of synchronization steps occur during connection. Synchronization flags changes made to
an MDECT system database by other managers.

Two types of synchronization occur when the connection state goes from Disconnected to
Connected, as follows:

• when you use the File menu or tool button to connect. You can control the synchronization
through dialogs.

• when the DECT Manager re-establishes a permanent connection to the MDECT system. A
synchronization report is available in the Event log on the DECT Manager.

When you connect to an MDECT system that has data that does not match the DECT Manager
Application data, choose one of the following:

• update the DECT Application database from the MDECT system data
• update the MDECT system data with the DECT Application database

DECT Systems window
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DECT System Properties dialog
This dialog displays the DECT System Properties:

• DECT System Properties dialog - General tab on page 31
• DECT System Properties dialog - Communication tab on page 32
• DECT System Properties dialog - Access Right Identification tab on page 33
• DECT System Properties dialog - Alarm tab on page 33
• DECT System Properties dialog - Parameters tab on page 33

DECT System Properties dialog - General tab
The General tab allows you to do the following:

• view the Meridian 1 PBX name
• view or change the DECT System name (see DECT System Name Missing dialog on

page 31 and DECT System Name Already in Use dialog on page 31)
• change the password (see Change password dialog on page 31)
• view if Concentration mode is active or Concentration mode is not active
• view the number of subscribed handsets

DECT System Name Missing dialog
The DECT System Name Missing dialog appears when a DECT System name is not entered.

The application will not allow a system to be saved unless a name has been provided and is unique.

DECT System Name Already in Use dialog
The DECT System Name Already in Use dialog appears when a DECT System name is the same
as the name of another system.

Change password dialog
The Change DECT System Password dialog is selected from the DECT System Properties dialog,
General tab.

DECT System Properties dialog
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If the new password does not match the confirmed password, a dialog warns you that the
passwords do not match and allows you to change the passwords.

DECT System Properties dialog - Communication tab
The DECT System Properties dialog is selected from the File menu.

The Communication tab allows you to do the following:

• view or change the unique IP address, used if the connection is Serial or Ethernet
• view the Subnetwork Mask
• view the Gateway IP address
• check a Permanent Connection, to:

- keep the connection open
- open the connection

• select Close Connection (see Close Connection dialog on page 32)
• select Ethernet or Serial connection
• select Details for the Serial connection (see DECT System Detailed Connection settings

properties on page 32)
• save a new MDECT system definition by pressing the OK button. This causes the manager to

try to connect to a new MDECT system and write the system name in MIB2, after you:

- enter the new system IP address
- specify the new system name

See also

• DECT System Detailed Connection settings properties on page 32

Close Connection dialog
The Close Connection dialog is selected from the DECT System Properties dialog, Communication
tab.

DECT System Detailed Connection settings properties
System Detailed Connection settings properties is selected from the Details button of DECT System
Properties dialog - Communication tab.

DECT Systems window
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The System Detailed Connection settings properties allows you to do the following:

• view or change the DECT Manager IP interface assigned to the PC RAS port interface on the
same network as the DECT system

• view or select the COM Port attached to either the DECT system or the modem
• select a modem mode
• view or change the Phone Number that dials the modem

DECT System Properties dialog - Access Right
Identification tab

The DECT System Properties dialog is selected from the File menu.

There are two Access Right Identification, a Primary and a Secondary, which identify each MDECT
system. The Access Right Identification allows you to do the following:

• view or change the PARI (see Change PARI dialog on page 46)
• view or change the SARI (A SARI dialog box is similar to the Change PARI dialog)

See also

• Change PARI dialog on page 46

DECT System Properties dialog - Alarm tab
The DECT System Properties dialog is selected from the File menu.

The Alarm allows you to do the following:

• view a Yes or NO in the active alarm when the manager is connected to an MDECT system
with an active alarm.

• view or change the Upstream Manager IP address. The MDECT system can send alarms to an
upstream manager.

• view or change the Date and Time, used to timestamp alarms. When not connected, the Date
and Time fields are blank. When the MDECT system is reset, the time and date are not
updated.

DECT System Properties dialog - Parameters tab
The DECT System Properties dialog is selected from the File menu.

DECT System Properties dialog - Access Right Identification tab
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The Parameters allows you to do the following:

• view or change Tone Duration in milliseconds
• view or change Inter Digit Pulse width in milliseconds
• view or change Level 1 - low frequency in decibels
• view or change Level 2 - low frequency in decibels
• view or change Analog/Digital loss pad- handset to system in decibels
• view or change Analog/Digital loss pad- system to handset in decibels
• set all parameters to Factory Default values

Do not use the Advanced button as it can cause your system to fail.

The DECT System Properties Parameters are read from the MDECT system on synchronization.

Firmware upload
The Firmware upload dialog is selected from the Firmware menu.

The designator DMC is used to differentiate between the NTCW00AA DMC and the NTCW00AB
DMC8.

This dialog alerts you that a DMC cannot support a firmware upload. If you select OK, a file chooser
lets you select a firmware file (see Firmware activation dialog on page 34), from the Client. When
OKis selected, you can replace the existing standby firmware with new firmware.

You can do one of the following:

• accept the firmware for the MDECT system
• cancel the firmware upload for the MDECT system

Firmware activation dialog
This dialog allows you to select the firmware to activate on DECT system.

DECT Systems window
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Chapter 7: Subscriptions window

The Subscriptions window is selected from the DECT Systems window Applications menu.

• What you can do with the Subscriptions window on page 35
• Subscriptions window definition on page 36
• Configure DECT subscription dialog on page 38
• Enable a subscription on page 38
• Disable subscriptions on page 39
• Delete subscriptions on page 39
• Copy subscriptions on page 40
• Move subscriptions on page 41
• Import subscriptions on page 41
• Export subscriptions on page 41
• Find subscriptions on page 41
• Synchronize DECT and Station Administration Configuration on page 42
• Meridian PBX to MDECT system synchronization on page 45
• Multi Site Mobility Networking subscriptions on page 45
• Force disable on page 47
• Subscription properties on page 47

What you can do with the Subscriptions window
This window allows you to:

• connect to, disconnect from, lock or unlock a connection between your DECT Manager and an
MDECT system

• choose to show, in any combination, (see Enable a subscription on page 38 and Disable
subscriptions on page 39) handsets that are:

- Available
- Subscribed
- Enabled
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- Blacklisted
- configured on one DMC8 or all DMC8s

• Subscribe (configure) handsets
• De-subscribe handsets
• Copy subscription data
• Move subscription data
• Delete subscription data
• Find subscription data
• Export subscription data
• Import subscription data

Note:
Before a handset will work, the handset must be programmed on the Meridian 1 PBX using LD
10.

Subscriptions window definition
The Subscriptions window displays the following:

• File, holds a pull-down menu allowing you to select one of the following:

- Import, a subscription from a file (see Import subscriptions on page 41)
- Export, a subscription to a file (see Export subscriptions on page 41)
- Connect, Lock, Unlock, Disconnect
- Properties, includes data in the subscription list and International Portable User Identifier

(IPUI) (see Subscription properties on page 47)
- Close, the Subscriptions window

• View, holds a pull-down menu allowing you to show or hide the:

- Tool bar
- Status bar

• Edit, holds a pull-down menu allowing you to open the following dialog boxes:

- Copy (see Copy subscriptions on page 40)
- Delete (see Delete subscriptions on page 39)
- Find (see Find subscriptions on page 41)

• Operations, holds a pull-down menu allowing you to open the following windows:

- Configure, allows you to program a handset on the Meridian 1 system (see Configure DECT
subscription dialog on page 38)

Subscriptions window
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- Set Default PARK, allows you to enter the default Portable Access Rights Key (see Multi
Site Mobility Networking subscriptions on page 45)

- Enable, allows you to subscribe a handset
- Disable, allows you to de-subscribe a handset from one MDECT system (see Disable

subscriptions on page 39) or de-subscribe a handset from all MDECT systems (see Multi
Site Mobility Networking subscriptions on page 45 for example)

- Force Disable, allows you to return the subscription to the available state, requests the
system to disable the subscription. However, there is no interaction between the system and
handset (see Force disable on page 47)

- Synchronize with Phone Data, allows the user to retrieve Meridian 1 handset configuration
from a CSV file generated using the EM Phone Provisioning application to synchronize and
resolve mismatches between Station Administration configuration and DECT Application
configuration (see Synchronize DECT and Station Administration Configuration on
page 42)

• Help, holds a pull-down menu allowing you to select:

- Content and Index
• Tool bar, allows you to click the tool button to:

- Connect, lock, unlock, disconnect, same function as DECT Systems window
- Enable, allows you to subscribe a handset
- Disable, allows you to de-subscribe a handset
- Configure, allows you to program a handset

• List filter, allows you to show or hide details of handsets that are:

- available (see Enable a subscription on page 38 and Disable subscriptions on page 39)
- subscribed (see Enable a subscription on page 38 and Disable subscriptions on

page 39)
- enabled (see Enable a subscription on page 38 and Disable subscriptions on page 39)
- black-listed (see Enable a subscription on page 38 and Disable subscriptions on

page 39)
- DMC restricts the list to subscription data for one DMC or lists subscription data for all DMC

• List, shows the following subscription details for handsets assigned to a <sitename>, a <PBX
name>, a <DECT system name>:

- DMC TN
- index, 32 units or 510 virtual units for concentration on a DMC
- concentrated handset Home DN
- concentrated handset Local DN, different than Home DN for visitor concentrated handset
- virtual TN for concentration handsets
- subscription PARK
- subscription status, updated by SNMP traps from the MDECT system
- PIN code shown during subscription activation

Subscriptions window definition
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- an 80-character comment
• Pop up menu, available when at least one subscription is selected, contains the following

items:

- Configure
- Enable
- Disable
- Copy
- Move
- Delete
- Export
- Properties
- Help

• Status bar, shows:

- connection status
- operation status
- current subscription PARK

Configure DECT subscription dialog
Configure DECT Subscription allows you to:

• select a DMC TN
• enter the first subscription index (unit, as in l s c u)
• select a number of consecutive subscriptions

When configured, the subscription becomes available and you can enable the subscription. During
the enable process, the DECT manager generates a PIN code for the subscription (see Enable a
subscription on page 38).

Enable a subscription
Available - DECT channel is configured and available for subscription.

Enabled - The subscription process starts with the user selecting the handsets and pulling down the
Operations menu and then clicking on Enable.

Pin code entered within 15 minutes? - The DECT Manager provides a PIN.

Subscribed – The handset is now ready to make and receive calls.

Subscriptions window
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Disable subscriptions
You can de-subscribe a subscription on:

• a single handset
• a list of selected handsets
• all handsets on a DMC

Subscribed – The handset can make and receive calls. The de-subscription process starts with the
user selecting the handsets and pulling down the operations menu then clicking on Disable.

Black listed – The following conditions must exist

• Connection with the system
• Handset in range
• Handset on
• Handset go off-hook or called

Available – Handset ready for subscription

Launching an on-air de-subscription requires an open connection to the MDECT system.

When the DECT Manager starts the de-subscription, the MDECT system holds the de-subscription
until one of the following occurs:

• the handset makes or receives a call
• the DECT Manager removes the subscription

The MDECT system notifies the DECT Manager that the handset is de-subscribed.

The DECT manager can stop a handset from operating on all the MDECT systems where the
handset is subscribed with a given International Portable User Identifier (IPUI).

To stop a handset from operating, requires that the handset is within radio range and ready for on-
air de-subscription. The process removes handset subscription data from the following:

• the MDECT system DMCs
• the handset
• the DECT managers handset and MDECT system files

When the handset's subscription data is removed, the handset no longer works on any MDECT
system.

Delete subscriptions
The Delete operation allows you to remove handset information from the manager and the MDECT
system, but not the handset. The Delete operation does not require the handset to be available for
on-air de-subscription. The Delete operation does the following:

• removes the MDECT system handset subscription data

Disable subscriptions
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• retains the handsets subscription data, if the handset had subscription data (As the handset
does not remove its subscription data, it continues operating on all the MDECT systems where
this subscription is relevant.)

• removes the DECT manager handsets subscription data including comments and Meridian 1
PBX Station Administration data

The DECT Manager provides the ability to remove subscription records from the following:

• a single handset subscription
• a list of selected subscriptions
• a DMC or from all DMCs at once

The subscription removal requires an open connection to the MDECT system.

You can remove subscription records to:

• clean a Multi Site Mobility Networking MDECT system subscriptions on the distributors
premises

• move a DMC from one MDECT system to another

Copy subscriptions
The Copy Subscription dialog is selected from the Edit menu.

The copy dialog allows you to copy subscriptions from a DMC on MDECT system A and paste the
subscriptions into a DMC on MDECT system B. The subscriptions have to be in the Subscribed
status.

You select the Destination MDECT system and the Destination DMC from the DECT Copy
Subscription dialog. The connection to the destination system must be open.

You can copy subscriptions from the following:

• a single handset subscription
• a list of selected subscriptions
• a DMC

Note:
You cannot copy subscriptions within the same MDECT system. When a subscription is copied,
only the MDECT system data is copied, not the Meridian 1 PBX data.

In the DECT Copy Subscription dialog the source subscription data is in the three left columns; DMC
TN, Index, and Local DN. You view the source subscription from the Subscription window. The
destination subscription data is in columns To: DMC TN, and To: Index. Index is the Unit on the
DMC. When the dialog opens, the source DMCs and destination DMCs are the same.

When you copy, you must connect to the destination MDECT system.

The Copy Subscription feature provides a way to support Multi Site Mobility Networking, by allowing
you to subscribe handsets without being on the Distributor Premises.

Subscriptions window

December 2015 Using the DMC DECT Manager 40
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Using the DMC DECT Manager


Move subscriptions
The Move Subscriptions dialog is selected from the Edit menu.

Move Subscriptions is similar to Copy, except for the following. The move dialog allows you to cut/
remove subscriptions from a DMC on MDECT system A, and paste the subscriptions into a DMC on
the same MDECT system, or MDECT system B.

When you move, you must connect to both the source MDECT system and the destination MDECT
system.

Import subscriptions
The Import Subscriptions dialog is selected from the File menu.

Import Subscriptions is similar to Copy, except for the following. The import dialog allows you to
copy subscriptions from an import file and paste the subscriptions into a DMC on an MDECT
system.

To paste a subscription, you must be connected to an MDECT system.

Export subscriptions
The Export Subscriptions dialog is selected from the File menu.

Export Subscriptions is similar to Copy, except for the following. The export dialog allows you to
copy subscriptions from an MDECT system and paste the subscriptions into a file.

Note:
Import/Export are used to support Multi Site Mobility Networking and Subscription on the
Distributor Premises to a MDECT system normally managed by TM "B", not your TM "A".

Find subscriptions
The Find Subscriptions dialog is selected from the Edit menu.

The Find operation allows you to find subscription information by searching for an IPUI or a Home
DN, using the Find DECT Subscription dialog.

The find action displays the subscription information in the Find DECT Subscription Result dialog.

Move subscriptions
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Synchronize DECT and Station Administration
Configuration

Synchronizing phone data from a CSV file generated using the EM Phone Provisioning application
allows the user to retrieve Meridian 1 handset configuration and resolve mismatches between
Station Administration configuration and DECT Application configuration. To synchronize DECT and
Station Administration Configuration, use the EM Phone Provisioning application to generate a CSV
file with phone details. A report profile is available under <DMC DECT Manager Root>/Data
directory. Upload the report profile to the EM Phone Provisioning application and generate the
required CSV file for DMC DECT.

The CSV report contains all phones having WTYP=’DECT’ and WRLS=’YES’ for a particular
element in Avaya Unified Communication Management (Avaya UCM). The CSV report has the
following format:

Table 1: CSV report format

Sl. No. Phone Feature Phone Feature Description
1 INDX Index on DMC
2 HMDN Home Directory Number
3 VSIT Visiting DECT Set
4 PRIMEDN Prime DN
5 TN Terminal Number
6 DMC DECT mobility controller

Synchronizing DECT and Station Administration Configuration
1. Select Start, Programs, DMC DECT Manager, DMC DECT Manager.
2. Select the required PBX System from the list of PBX systems and click Ok.

Figure 24: DMC DECT System window

The DMC DECT System window appears.
3. Select the required DECT System and click Applications, Subscriptions.

Subscriptions window
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Figure 25: Applications Subscriptions

4. Click on Subscriptions.

The Subscription window appears.

Figure 26: Subscription window

5. Click on Operations, Synchronize with phone data

Figure 27: Operations Synchronize with phone data

6. Click on Synchronize with phone data. Browse to the CSV report having phone data and
click Import.

Synchronize DECT and Station Administration Configuration
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Figure 28: Import Subscriptions

The DECT and Station Administration Mismatch window appears, if there is a mismatch
between the DMC DECT Manager data and the CSV report.

Figure 29: DECT and Station Administration Mismatch

If there is no mismatch, synchronization is completed and the subscriptions in the CSV file
are imported to DMC DECT Manager.

Subscriptions window
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Figure 30: Subscriptions Imported

Meridian PBX to MDECT system synchronization
If the Meridian PBX configuration data is available in the form of a CSV file generated from the EM
Phone Provisioning application, then a synchronization facility is available to import the data into
DMC DECT Manager. Synchronization follows the following rules:

• A handset not listed in the DECT Manager but present in the PBX is added in the DECT
Manager list.

• If the DECT Manager lists a handset but the CSV file does not, the DECT Manager prompts
you to either keep or remove the handset.

Add handsets to the DECT manager by selecting Configure from the Operations menu.

The Synchronize DECT and Station Administration Mismatch dialog highlights DMC TNs in the
DECT managers that are not configured in the EM Phone Provisioning application database. You
can check those subscriptions that you must keep in the DECT manager.

If there is no mismatch that DECT Manager cannot resolve automatically, the Synchronize DECT
and Station Administration dialog does not appear. For example, there are no entries in the EM
Phone Provisioning application database, or the DECT Manager does not have a DMC configured in
a Meridian 1 PBX TN location, where an entry does exist in the EM Phone Provisioning database.

Multi Site Mobility Networking subscriptions
In Multi Site Mobility Networking (MSMN), a handset is subscribed in a given MDECT system and
used in one or many MDECT systems.

Every handset has a Portable Access Rights Key (PARK). Every MDECT system has a Primary
Access Rights Identifier (PARI), and can have a Secondary Access Rights Identifier (SARI).

The handset PARK and MDECT system PARI and SARI are used by the handset and MDECT
system to identify each other. The PARK and PARI/SARI match allow the handset to work with an
MDECT system.

Meridian PBX to MDECT system synchronization
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In an MSMN network, for example, MDECT system "A" has a PARI matching a handset PARK and
MDECT systems "B", "C", and "D" have a SARI matching the handset PARK.

The DECT Manager user programs the SARI in the MDECT system. The DECT Manager provides
the PARK during the on-air subscription, and the PARK is programed into the handset at
subscription time (see DECT System Properties dialog - Access Right Identification tab on
page 46 and Change PARI dialog on page 46).

For example, you can subscribe a handset on an MDECT system on a distributors premises, where
the handset is not to be in operation. You then download the subscription data to an MDECT system
where the handset is to be in operation. The PARI of the MDECT system where the handset is
subscribed and the SARI of the MDECT system where you use the handset are not always the
same. You provide the PARK matching the destination MDECT system to the handset during the
on-air subscription.

The DECT Manager provides the ability to specify the PARK given to the handset, to support Multi
Site Mobility Networking and Subscription on the distributor premises (see Change PARI dialog on
page 46). The PARK normally defaults to the PARI of the system where the on-air subscription
occurs. For MSMN, you must set the default PARK equal to the network SARI value before any
subscription activity.

The PARK used by the DECT subscription application is subject to the following:

• PARK is limited to the lifetime of the subscription application
• two different users can use a different PARK on the same MDECT system at the same time
• PARK is not recorded in persistent storage

DECT System Properties dialog - Access Right Identification tab
The DECT System Properties dialog is selected from the File menu.

There are two Access Right Identification, a Primary and a Secondary, which identify each MDECT
system. The Access Right Identification allows you to do the following:

• view or change the PARI (see Change PARI dialog on page 46)
• view or change the SARI (A SARI dialog box is similar to the Change PARI dialog)

See also

• Change PARI dialog on page 46

Change PARI dialog
The Change PARI dialog appears when you press the Change PARI button of the Access Right
Identification.

You must not change the PARI or SARI until you connect to the MDECT system requiring the new
PARI or SARI.

During synchronization, a dialog warns you if a MDECT system has a different PARI or SARI than
the DECT manager.

Subscriptions window
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See Multi Site Mobility Networking subscriptions on page 45 for additional information about
changing the PARI and SARI.

Force disable
The Force disable DECT Subscriptions dialog is selected from the Operations menu.

Force Disable returns the subscription to the available state, requests the system to disable the
subscription. However, there is no interaction between the system and handset.

You can use Force Disable when the handset is not in range or on-air.

Use on this DECT System only if you want to remove the handset subscription from only this
MDECT system and remove the handset subscription from all other MDECT systems in the
background.

Use on all DECT Systems where it is present? if you want to remove the handset subscription
from all systems at the same time.

Subscription properties
The Subscription properties sheet is selected from the File menu.

• What you can do with the Subscription properties sheet on page 47
• Subscription properties sheet definition on page 48

What you can do with the Subscription properties sheet
This properties sheet allows you to:

• view the DMC Terminal Number
• view the Index. Index is the TN unit, as programmed in LD 10 in a non-concentrated system,

and a virtual TN unit in a concentrated system.
• change and apply Comments, up to 80 characters
• view Home Directory Number (where the handset is configured on the Meridian PBX as the

home location)
• view Local Directory Number
• view Home handset only
• view handset Virtual Terminal Number
• view the International Portable User Identifier (IPUI)
• view the subscription PARK
• view the subscription status

Force disable
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• view the subscription PIN

Subscription properties sheet definition
The Subscription properties sheet displays the same subscription data as the Subscriptions window
list items.

Subscriptions window
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Chapter 8: Boards (DMC) window

The Boards window is selected from the DECT Systems window Applications menu:

• What you can do with the Boards (DMC) window on page 49
• Boards (DMC) window definition on page 49
• Board (DMC) properties sheet on page 50

What you can do with the Boards (DMC) window
This window allows you to:

• examine DMC details
• connect to, disconnect from, lock or unlock a connection between your DECT Manager and an

MDECT system
• choose to show operational DMC, or non-operational DMC or both
• open a properties sheet

Boards (DMC) window definition
The Boards window displays the following DMC data:

• File, holds a pull-down menu allowing you to select one of the following:

- Clear, erases all subscriptions, sets all base stations to installed status and line powered,
allowing you to program the DMC in a new MDECT system

- Connect, Lock, Unlock, Disconnect, works the same as the Connect/Disconnect tool
- Properties
- Close, closes the DMC window

• View, holds a pull-down menu allowing you to show or hide the:

- Tool bar
- Status bar
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• Synchronization, holds a pull-down menu allowing you to:

- Synchronize From, subscription and base station alarm muting/power source configuration
data from a DMC to the DECT Manager

- Synchronize To, subscription and base station alarm muting/power source configuration
data from the DECT Manager to a DMC

• Help, holds a pull-down menu allowing you to select:

- Content and Index
• Tool bar, allows you to click the tool button to:

- Connect, lock, unlock, disconnect
• List filter, allows you to show list details of only the operational DMC or non-operational DMC

or both
• List, shows the following DMC details:

- DMC TN
- DMC type
- relay DMC
- operational state, when DMC operational status changes, the DECT Manager updates the

status
- Number of handsets on a DMC
- an 80-character comment

• Pop up menu,

- Synchronize from DMC
- Synchronize to DMC
- Properties
- Help

• Properties, displays additional information about DMC. Only the comment can be modified.

Board (DMC) properties sheet
The Board properties sheet is selected from the File menu.

• What you can do with the Board properties sheet on page 50

What you can do with the Board properties sheet
This properties sheet allows you to:

• view DMC details

Boards (DMC) window
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• view operational status. When the DMC operational status changes on the MDECT system, the
TM updates the status

• change and apply Comments, up to 80 characters
• view DMC Type Number
• view DMC Manufacture Code
• view DMC Standby Software Package
• view DMC Boot Package
• view DMC Protocol Version
• open the help file
• close the properties sheet

Board (DMC) properties sheet
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Chapter 9: Radio Fixed Part (base station)
window

The Radio Fixed Part window is selected from the DECT Systems window Applications menu:

• What you can do with the Radio Fixed Part (base station) window on page 52
• Radio Fixed Part (base station) window definition on page 52
• Radio Fixed Part (base station) properties sheet on page 53

What you can do with the Radio Fixed Part (base station)
window

This window allows you to:

• examine base station details
• connect to, disconnect from, lock or unlock a connection between your DECT Manager and an

MDECT system
• choose to show Muted base stations, or Not Muted base stations or both
• cancel mute allows a base station to generate alarm messages or mute keeps a base station

from generating alarm messages
• open a properties sheet

Radio Fixed Part (base station) window definition
The Radio Fixed Part window displays the following base station data:

• File, holds a pull-down menu allowing you to select one of the following:

- Connect / Lock / Unlock / Disconnect, same functions as the Connect / Disconnect tool
- Properties, opens the Radio Fixed Part properties sheet
- Close, closes the Radio Fixed Part window

• View, holds a pull-down menu allowing you to show or hide the:

- Tool bar
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- Status bar
• Edit, holds a pull-down menu allowing you to:

- Mute Alarms, keeps a selected base station from generating alarms
- Cancel Mute Alarms, allows a selected base station to generate alarms

Note:
You can view alarms on the Active Alarm Snapshot window.

• Help, holds a pull-down menu allowing you to select:

- Content and Index
• Tool bar icon, allows you to click the tool button to:

- Connect, lock, unlock, disconnect
- Mute Alarms, keeps a selected base station from generating alarms
- Cancel Mute Alarms, allows a selected base station to generate alarms

• List filter, allows you to select a list showing base stations allowed to generate alarms, or base
stations not allowed to generate alarms, or both

• List, displays:

- DMC TN, connected to a base station
- Radio Identifier, identifies the base station (1 to 4) connected to the DMC and the base

station (1 to 8) connected to the DMC8
- Operational State, indicates if a base station is operational or is not operational
- Alarm Muted, indicates if a base station is allowed to generate alarms or not
- Number of Channels, identifies the base station as either a 6-channel or a 12-channel base

station
- Comment, an 80-character comment field in the DECT application

• Pop-up menu, appears when at least one RFP is selected, and you right click the mouse.
Selecting one or more Radio Fixed Part (click/double-click on a Radio Identifier or highlight a
row in the list) displays a menu with the following:

- Properties
• Help allows you to select Content and Index or About DECT application

Radio Fixed Part (base station) properties sheet
The Radio Fixed Part properties sheet is selected from the pop-up menu.

• What you can do with the Radio Fixed Part properties sheet on page 54
• Radio Fixed Part properties sheet definition on page 54

Radio Fixed Part (base station) properties sheet
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What you can do with the Radio Fixed Part properties sheet
This properties sheet allows you to:

• view base station details
• view Operational Status. When base station operational status changes, the DECT Manager

updates the status
• change and apply Alarm Muting
• change and apply Comments, up to 80 characters
• select Line Power (powered by DMC) or Local Powered
• open the help file
• close the properties sheet

Radio Fixed Part properties sheet definition
The Radio Fixed Part properties sheet displays the same base station data as the Radio Fixed Part
window list items. The properties sheet also shows the power source for the selected base station.

Radio Fixed Part (base station) window
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Chapter 10: Active Alarm Snapshot window

The Active Alarm Snapshot window is selected from the DECT Systems window Applications menu.

• What you can do with the Active Alarm Snapshot window on page 55
• Active Alarm Snapshot window definition on page 55
• Active Alarm Snapshot properties sheet on page 56

What you can do with the Active Alarm Snapshot window
This window allows you to:

• connect to the Active Alarm Snapshot window
• refresh the window
• open a properties sheet

Active Alarm Snapshot window definition
The Active Alarm Snapshot window displays the alarm data stored in the DMC. The alarm data
displayed does not change or update until manually refreshed

• File, holds a pull-down menu allowing you to select one of the following:

- Connect / Lock / Unlock / Disconnect, same functions as the Connect / Disconnect tool
- Properties, opens the Active Alarm Snapshot properties sheet
- Close, closes the Active Alarm Snapshot window

• View, holds a pull-down menu allowing you to select:

- Tool bar, to show or hide
- Status bar, to show or hide
- Refresh, updates the Active Alarm Snapshot window with the latest alarm data from the

MDECT system selected in the title bar. You cannot select a separate DMC TN to refresh.
• Help, holds a pull-down menu allowing you to select:

- Content and Index
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• Tool bar, allows you to click the tool button to:

- Connect, lock, unlock, disconnect
- Refresh, updates the Active Alarm Snapshot window with the latest alarm data from the

MDECT system selected in the title bar. You can not select a separate DMC TN to refresh.
• List, shows read-only data about:

- Severity, always labeled as Critical
- Error Code, a three digit code. Refer to the Meridian Companion DECT Operation

Administration and Maintenance technical publication for the meaning of the Error Codes
- DMC TN, indicates the location of the card that originated the alarm
- Radio Identifier (base station identifier), indicates the base station that is the source of an

alarm
- Date and Time, when the alarm occurred
- Operator Data, describes the alarm and the faulty component if applicable

• Pop-up menu, appears when at least one RFP is selected, and you right click the mouse.

- Properties
• Help displays Content and Index, and About DECT application

Active Alarm Snapshot properties sheet
The Active Alarm Snapshot properties sheet is selected from the pop-up menu.

• What you can do with the Active Alarm Snapshot properties sheet on page 56
• Active Alarm Snapshot properties sheet definition on page 56

What you can do with the Active Alarm Snapshot properties sheet
This properties sheet allows you to:

• view alarm (MDECT system message) details
• close the properties sheet
• open the help file

Active Alarm Snapshot properties sheet definition
The Active Alarm Snapshot properties sheet displays the same alarm data as the Active Alarm
Snapshot window list items.

Active Alarm Snapshot window

December 2015 Using the DMC DECT Manager 56
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Using the DMC DECT Manager


Chapter 11: Performance Collection
window

The Performance Collection window is selected from the DECT Systems window Applications
menu.

• What you can do with the Performance Collection window on page 57
• Performance Collection window definition on page 57
• Performance Collection additional information on page 57

What you can do with the Performance Collection window
This window allows you to:

• start and stop User Performance Collection counters
• start and stop Equipment Performance Collection counters

Performance Collection window definition
The Performance Collection window displays the following:

• Name, allows you to select the directory where you want to store the Performance Collection
file.

• User Performance Collection, collects counter data on handset user related activities.
• Equipment Performance Collection, collects counter data on DMC related activities.

Performance Collection additional information
The DECT Manager user starts and stops performance counter collection. You can not schedule
performance collection. The collection begins when you start it and ceases when you stop it.

You can set the collection period for 15 minutes, 30 minutes, one hour, one day. The performance
counters are on the DMCs. You can select DMC TNs.
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You can collect User (handset) data and Equipment (MDECT system) data separately. You can set
User (handset) data and Equipment (MDECT system) data collection periods separately.

The DECT Manager stores the performance files. Rebooting the DECT Manager does not destroy
the files. The back up and restore application on the DECT Manager does not back up and restore
the performance files.

Performance Collection window
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Chapter 12: Retrieve RSSI Snapshot
window

The Retrieve RSSI Snapshot window is selected from the DECT Systems window Applications
menu.

• What you can do with the Retrieve RSSI Snapshot window on page 59
• Retrieve RSSI Snapshot window definition on page 59
• Retrieve RSSI Snapshot attributes on page 59

What you can do with the Retrieve RSSI Snapshot window
This window allows you to:

• view Radio Signal Strength Indication details
• scroll and select a DMC for RSSI information retrieval

Retrieve RSSI Snapshot window definition
The Retrieve RSSI Snapshot window collects, on request, the RSSI for selected DMC.

Retrieve RSSI Snapshot attributes
The DECT Manager collects the RSSI as an ASCII file. The DECT Manager user must indicate
where to store the RSSI file.
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Chapter 13: Backup and Restore utility

• Backup DECT data on page 60
• Restore DECT data on page 61

DECT Data Backup and Restore operations are performed using the DMC DECT Backup and
Restore utility.

The DECT Data backup file contains all configured PBX Systems, corresponding DECT systems
and other configuration data compressed in a file with .bak extension.

The Backup utility automatically generates a backup file name during a backup operation. The user
can change the filename, if required, but, the filename should always have .bak extension. A backup
file, by default, has the following format: DMC_DECT_BACKUP_mm_dd_yyyy.bak

During the restore operation, a user selects a backup file and replaces the existing configuration in
the DMC DECT Manager with the configuration available in the backup file. Note that the restore
operation does not compare the data in the backup file with existing data.

Backup DECT data
1. Click Start, Programs, DMC DECT Manager, Backup Restore Utility

Figure 31: Backup and Restore

2. Select the Backup option. (The backup option is selected by default.)
3. Click the File browse button to select the directory and provide the backup file name. Ensure

that the file extension is .bak.

Figure 32: Browse to select directory

4. Click OK.
5. Click Yes to proceed with the backup.
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Figure 33: Backup confirmation

6. Click OK.

Figure 34: Backup completed

Note that

• Basic validation is performed during the backup operation.
• File name is mandatory
• Verify the extension of the file. File extension must be .bak

Restore DECT data
1. Click Start, Programs, DMC DECT Manager, Backup Restore Utility

Figure 35: Backup and Restore

2. Select the Restore option. (The backup option is selected by default.)

Figure 36: Restore option

3. Click the File browse button to select the DECT backed up file.

December 2015 Using the DMC DECT Manager 61
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Using the DMC DECT Manager


Figure 37: Browse to backed up file

4. Click OK.
5. Click Yes to proceed with the restore.

Figure 38: Restore confirmation

6. Click OK.

Figure 39: Restore completed

Backup and Restore utility
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